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1.	 a.	(ii)	 b. (i)	 c. (iii)	 d. (ii)	 e. (ii)
	 f.	 (i)
2.	 a.	bit	 b. OFF	 c. base-2 system	 d. 12	 e. binary
3.	 a. Byte	 b. Base-10 system	 c. 10	 d. Hexadecimal Number System 
4.	 a. A number system made up of eight digits from 0 to 7, is known as the octal number system. 

When the octal number system is used, every number is formed using 0,1,2,3,4,5,6 and 7. The 
base of the octal number system is 8. It is also known as the base-8 system. Each positioning 
number represents the power of base 8.

	 b. A number system is a way to express quantities used for counting, comparing amounts, 
performing calculations and representing values. A computer represents all kinds of data 
and information like text, numbers, audio and video in binary form. 

		  Example: Decimal Number System.
	 c. The total number of digits used in a number system is called its base or radix.
	 d. The smallest piece of data that can be recognised and used by the computer is known as the 

bit or binary digit. A bit is a single binary value i.e., 1 or 0. A computer is an electronic device 
which has two states: On and Off. These two states of the computer are represented by two 
digits: 1 and 0. Here, 1 represents the electronic state On, and 0 represents the electronic 
state Off.

1.
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	 e. To convert a binary number into a decimal number, follow the given steps: 
		  1 	� Multiply each digit of the binary number by 2 to the power of n, where n is the position 

of the digit starting from 0 on the right. 
		  2 	 Add the result. 
	 Example:
		  Convert (101001)2 to decimal number. 
		  = (1×25) + (0 × 24) + (1 × 23) + (0 × 22) + (0 × 21) + (1 × 20)
		  Sum of the products = 32 + 0 + 8 + 0 + 0 + 1 = 41 
		  Therefore, (101001)2 = (41)10

	 f.	 In binary subtraction, the smaller binary number is subtracted from the larger one. The table 
below illustrates how to subtract digit Y from digit X. If Y is greater than X, we borrow 1 from 
the next higher position. When a binary digit of 0 borrows 1, it effectively becomes 2 (written 
as 10 in binary). The rules for binary subtraction: 

X Y X – Y

0 0 0 – 0 = 0

0 1
0 – 1 = 1 

(borrow 1, so that 10 – 1 
= 1)

1 0 1 – 0 = 1

1 1 1 – 1 = 0

5.	 a. 	i.	 5	 ii.  11111010	
		  iii.	 43	 iv.  187
	 b.	i.	 11001
		  ii.	 1101
6.	 Do it yourself.
7.	 a. (256)8: This number system belongs to octal number system. 
	    (10001)2: This number system belongs to binary number system. 
	    He can tell by observing the base of the number system. 
	 b. Hexadecimal number system
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Even when the data is arranged in ascending or descending order, it can still be sorted again within 
another column using custom sorting.

 

1.	 a.	(iii)	 b. (i) 	 c. (ii)	 d. (i)	 e. (ii)
2.	 a.	Sorting	 b. Filter	 c. Home	 d. AVERAGE()	 e. Add level
3.	 a.	The IF() function checks a condition to evaluate it as true or false, and based on the result, 

suitable actions are performed. This function takes three arguments into consideration: the 
condition, the value to be displayed when the condition is true, and the value to be displayed 
when the condition evaluates to be false.

	 b.	To remove filter, follow the given steps:
		  1 	 Click on Sort & Filter command.
		  2 	 Select Filter option from the drop-down menu
	 c.	Even when the data is arranged in ascending or descending order, it can still be sorted again 

within another column. For example, if Student’s mark list is sorted with respect to Roll No. 
column, we can still sort it in the Name column. You can do this in Excel using Custom Sort. 

	 d. To apply conditional formatting to a series of data, follow the given steps:
		  1 	 Select the data and click on the Conditional Formatting command.
		  2 	 Select the desired option.
		  3 	 Choose desired fill effect.
	 e.	Excel allows us to see the important data and hiding the rest temporarily data from the set 

of data. To apply filters, follow the steps given below:
		  1 	 Select the data to be filtered and click on the Sort & Filter command.
		  2 	 Select the Filter option.
		  The list appears with the drop-down controls or the Filter switches on the right side of the 

column headings.

2.
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		  3 	 Click on Filter Switch.
		  4 	 Tick the desired checkbox.
		  5 	 Click OK button
4.	

i. � The feature of viewing rows of data suiting 
a specified selection criterion is called 
filtering data.

ii. � Filtering enables us to display important 
data while temporarily hiding the rest of 
the dataset.

i. � The physical arrangement of data 
in ascending or descending order is 
called sorting of data. 

ii. � It allows arranging the data either in 
ascending or descending order. 

Sorting Data Filtering Data

5.	 a.	Sort in Ascending order
	 b.	Conditional Formatting
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a.	 45 3 135×

b.	 125 5 25

c.	 36 82 14 132

 More on Krita

 

1.	 a. (ii) 	 b. (ii)	 c. (ii)	 d. (ii)	 e. (ii)

2.	 a. Tab 	 b. Polygonal Selection 	 c. Layer	 d. Ctrl + ]

3.	 a.	Resize Canvas	 b. Selection Tools	 c. Ctrl + Shift + A	 d. Freehand Selection Tool
4.	 a.	� Layers are used to separate different parts of an artwork so you can edit them individually 

without affecting other parts. They allow better control over your drawing, help organize 
complex artwork, and make it easier to apply changes or effects.

3.
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3.

	 b.	 1  Select the Gradient Tool from the toolbox (or press G).
		  2  Choose a gradient style from the Tool Options docker.
		  3  Click and drag on the canvas where you want the gradient to appear.
		  4  Release the mouse to apply the gradient between the start and end points.
	 c.	 1  Right-click on the layer you want to duplicate in the Layers docker.
		  2  Select "Duplicate Layer" from the context menu.
		      The duplicated layer will appear above the original.
	 d.	 1  Select "New", then choose the type of layer (e.g., Paint Layer).
		  2  Alternatively, click the "+" (Add Layer) button at the bottom of the Layers docker.
		  3  A new layer will be added, ready for drawing or editing.
5.	 a.	Samaira can use layers in Krita to manage her artwork efficiently:
		  1  Import the road image onto the background layer.
		  2  �Create a new layer for each character image and import them separately. Each character 

can be placed and edited independently.
		  3  �She can resize, move, or adjust each character without affecting the background or other 

characters.
		  Benefits of using layers:
		  •  Non-destructive editing: Changes made on one layer do not affect others.
		  •  Flexibility: Characters and background can be moved or edited anytime.
		  •  Better organization: Each part of the composition is managed separately.
		  •  �Layer effects: She can apply shadows or filters to characters individually for a more realistic 

look.
		  Using layers enhances the workflow, saves time, and gives more creative control, especially 

in detailed or complex digital art projects.
	 b.	For Gunjan, the best tool to use in Krita for accurately selecting the shirt and pants would be 

the Polygonal Selection Tool or the Bezier Curve Selection Tool.
		  These tools allow her to:
		  •  �Manually trace around the edges of the shirt and pants with precision.
		  •  �Make clean, straight-edged selections, especially useful when dealing with complex outlines 

or clear borders.
		  •  �Modify or refine the selection easily before applying color changes.
		  Advantages of using these tools:
		  •  �Greater accuracy and control over the selection process.
		  •  �Ability to select irregular or complex shapes with precision.
		  •  �Avoids selecting unwanted parts of the image (like skin or background).
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		  •  �Ensures clean color fills or edits, resulting in more professional-looking designs.
		�  By using these tools, Gunjan can experiment with different color combinations quickly and 

visualize her designs without redrawing the entire outfit.
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1.	 (c) 300	 2. (a) 52	 3. (c) TVX	 4. (c) 4

Periodic Assessment 1
(Based on chapters 1 to 3)

1.	 a. (iii)	 b. (i)	 c. (iv)	 d. (ii)
2.	 a.	IF(): The IF() function checks a condition to evaluate it as true or false, and based on the result, 

suitable actions are performed.
	 b.	SUM(): The SUM() function adds all the numbers in a range of cells and returns the total.
3.	 a. Editing	 b. Filter	 c. Sort	 d. Conditional Formatting

4.	 1. (c)		  2. (d)	 3. (b)	 4. (a)

 Lists and Tables in HTML5

uiz Bee
Page-61

Border

 

1.	 a. (ii)	 b. (i)	 c. (ii)	 d. (i) 	 e. (ii)
2.	 a. <LI>	 b. style-type 	 c. <TR>	 d. border-collapse
3.	 a. border-width	 b. <DD>	 c. Nested list	 d. start
4.	 a.	The syntax for using the list-style-type property is: <UL Style = "list-style-type:value">
	 b. A description list is used to list formatting for defining terms on a web page. It is also called 

a definition list.  

4.
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4.

	 c.	We use padding to add space between the border and the contents of a cell. We can use 
spacing to increase the border size or distance between cells. Since the table contents are 
present in <TH> and <TD>, the padding property is declared for these two elements in the 
style tag.

	 d.	The border property is used to define the border of a table.
		  HTML codes to use border property:
	 	 <!DOCTYPE html> 

	 	 <HTML> 

	 	 <HEAD> 

	 	 <TITLE>A Simple Table Structure</TITLE> 

	 	 <STYLE> 

	 	 Table 

	 	 {

	 	 border:2px solid blue; 

	 	 }

	 	 </STYLE> 

	 	 </HEAD> 

	 	 <BODY> 

	 	 <TABLE> 

	 	 <CAPTION>STUDENT’S DETAILS</CAPTION> 

	 	 <TR> 

	 	 	 <TH>ADMISSION</TH> 

	 	 	 <TH>NAME</TH> 

	 	 	 <TH>TOTAL MARKS</TH> 

	 	 </TR> 

	 	 <TR> 

	 	 	 <TD>2016/0256</TD> 

	 	 	 <TD>Aadya Kaushal</TD> 

	 	 	 <TD>589</TD> 

	 	 </TR> 

	 	 <TR> 

	 	 	 <TD>2017/0865</TD> 

	 	 	 <TD>Shweta Kaushal</TD> 

	 	 	 <TD>545</TD> 

	 	 </TR> 

	 	 </TABLE> 

	 	 </BODY> 

	 	 </HTML>
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	 e.	Tables help organize and display data in a structured, row-and-column format, making 
information easy to compare, read, and understand—especially useful for schedules, price 
lists, or reports.

	 f.	 Unordered List Ordered List

Displays list items with bullets. Displays list items with numbers or letters.

The order of items does not matter. The order of items is important.

Created using the <ul> tag. Created using the <ol> tag.

Example: Grocery list. Example: Step-by-step instructions.

5.	 a.	<ol type = "I">
	 b.	<table style="border: 2px solid black;">

COding Zone
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a.	 <ol> 

	 <li> Cricket: 

		  <ul> 

		  <li> Bat </li>

		  <li> Ball </li>

		  <li> Helmet </li>

		  </ul> 

	 <li> Table Tennis: 

		  <ul> 

		  <li> Table </li>

		  <li> Paddles </li>

		  <li> Ping pong ball </li>

		  </ul> 

	 <li>

	 </ol> 

b.	 <ul Style = "list-style-type:circle"> 

		  <li> Monday </li>

		  <li> Tuesday </li>

		  <li> Wednesday </li>

		  <li> Thursday </li>

		  <li> Friday </li>

		  </ul> 
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 Images, Links and Forms in HTML5

uiz Bee
Page-70

1.	� ALT is used to display alternative text, if selected image is not displayed.
2.	� Interlinking (Local): The process of linking a particular section of the same web page is called 

interlinking. 
	� Intralinking (Global): The process of linking a web page to another web page of the same website 

or another website is called intralinking.

1.	 a. (iii)	 b. (i)	 c. (ii)	 d. (iii)	 e. (i)
2.	 a. hyperlink	 b. anchor	 c. Frames	 d. frameset
3.	 a.	Internal linking connects to pages within the same website. It uses relative URLs, such as 

`about.html`, and helps users navigate easily within the site. On the other hand, external 
linking connects to pages on different websites. It uses absolute URLs, like `https://example.
com`, and is used to direct users to outside resources or references.

	 b.	Input controls are the elements which are used to accept input from the site-visitors. All the 
controls have to be filled before submitting the form. 

	 c.	The images on a web page can be inserted using the <IMG> tag, which is an empty tag. 
		  Syntax of <IMG> tag: 
		  <IMG SRC="URL of the image" ALT="alternate text" WIDTH="500" 

HEIGHT="600"> 

		  ALT = "Alternate Text" 
		  WIDTH = "Value of width in pixels" 
		  HEIGHT = "Value of height in pixels" 
		  ALIGN = "Alignment Type" 
		  It has the following attributes:

5.
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URL (or location) of the 
image

Text

SRC

ALT

SRC stands for source. It specifies the 
location of the image.

ALT stands for alternate text. It specifies 
which alternative text should be displayed, 
if selected image is not displayed.

Attribute Value Description

	 d.	Border properties can be applied in the following ways: 
		  border-width:value Where value = thin, thick, medium, or numeric values specified in pixels. 
		  border-style:value Where value can be specified as none, hidden, dotted, dashed, solid, 

double, groove, ridge, inset, or outset
	 e.	Frames(inline) are created using <iframe> tag, which embeds an independent HTML document 

into the current document.
	 Syntax: 
		  <iframe src="url" title="description"></iframe> 
		  We use the src attribute to specify the URL of the document that contains the inline frame 

and the title attribute to describe the content of the iframe. 
		  Attributes of <iframe> tag are: 
		  Height: Used to control the height of the iframe and its values can be specified in pixels or 

percentage. (px or %). 
		  Width: Used to control the width of the iframe and its values can be specified in pixels or 

percentage. (px or %). 
	 Example: 
	 <!DOCTYPE HTML> 

	 <HTML> 

	 <HEAD> 

	 <TITLE> iframes Example </TITLE> 

	 <Style Type = "text/css"> 

	 Body {Background-Color:Grey} 

	 </Style> 

	 </HEAD> 

	 <BODY> 

	� <H1 ALIGN = "CENTER"> Example of double spread containing inline frames 
</H1> 

	 <iframe src = "Frame1.html" Height = "200" Width = "200"> </iframe> 

	 <iframe src = "Frame2.html" Height = "200" Width = "200"> </iframe> 

	 </BODY> 

	 </HTML>

	 f.	 ACTION: This attribute specifies what action should be taken once the SUBMIT button is 
clicked by the user. The Script URL specifies the location where the data collected by the 
form is submitted. It also produces a response in return. 

		  METHOD: This attribute specifies what will happen when the form is submitted. Two values 
can be assigned to the METHOD attribute, Get and Post. 

4.	 a. <a href="link of website"> 

	 b. <iFrame> tag

COding Zone
COding Zone
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{} </>

<VIDEO SRC = "D:\Song.mp4" WIDTH = "300" HEIGHT = "300" AUTOPLAY CONTROLS> 

</VIDEO> 

 Developing Mobile Apps

uiz Bee
Page-91

This view contains all the components required to design an application. 

 

1.	 a. (i)	 b. (iv)	 c. (iv)	 d. (i)	 e. (i)
2.	 a. (F)	 b. (T)	 c. (T)	 d. (T)	 e. (F)
3.	 a.	Components Pane: It displays all the components (like Buttons, Labels, etc.) that are added 

to your app and shows the structure of your project.
	 b.	The three components of block editor window are:
		  •  Toolbox (with built-in blocks)
		  •  Workspace (where you drag and connect blocks)
		  •  Trash (to delete blocks)

6.
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	 <iframe src = "Frame2.html" Height = "200" Width = "200"> </iframe> 

	 </BODY> 

	 </HTML>

	 f.	 ACTION: This attribute specifies what action should be taken once the SUBMIT button is 
clicked by the user. The Script URL specifies the location where the data collected by the 
form is submitted. It also produces a response in return. 

		  METHOD: This attribute specifies what will happen when the form is submitted. Two values 
can be assigned to the METHOD attribute, Get and Post. 

4.	 a. <a href="link of website"> 

	 b. <iFrame> tag
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	 c.	 1  Go to Design View.
		  2  Click on the button component.
		  3  In the Properties pane, change the Text property to the desired display name.
	 d.	Following are the steps to delete an app:
		  1  Tap the Settings icon on your mobile screen.  
		  2  Tap on the Apps icon. 
		  3  Tap on the Manage apps option. 
		  4  Select the App’s icon by tapping on it. 
		  5  Tap on the Uninstall icon.
4.	

i.  �Used to program the behavior of the app 
using blocks.

ii. � You connect logic blocks to define how 
components work.

i. � Used to design the user interface of 
the app.

ii. � You add components like buttons, 
labels, etc.

Design View Block Editor View

5.	 a.	Sagar can find components in the Palette Pane of the Design View in App Inventor.
	 b.	Aruna can use the Android Emulator provided by App Inventor or test the app using the AI 

Companion on a web browser.

COding Zone
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a.	 (b) EGHI	 b.  (b) 24

Periodic Assessment 2
(Based on chapters 4 to 6)

1.	 <!DOCTYPE HTML>

	 <HTML>

	 <HEAD>

	 <TITLE> LIST </TITLE>

	 </HEAD>

	 <BODY>

	 <H2> Example of Definition List </H2>

	 <HR>
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	 <DL>

	 <DT> Beverages </DT>

	 <DD> Hot and Cold Drinks </DD>

	 <DT> Cappuccino </DT>

	 <DD> Hot Drinks </DD>

	 </DL>

	 </BODY>

	 </HTML>

2.	 Border: To set the width of an image border. 
	 Height: To set the height of an image. 
	 Width: To set the width of an image. 
3.	 a.	The SRC (source) attribute is used in the <img> tag to specify the path or URL of the image 

to be displayed. It tells the browser where to find the image file to load on the web page.
	 b.	Input controls are elements used in HTML forms to collect user input. Examples include text 

boxes, radio buttons, checkboxes, dropdown menus, etc.
4.	 a. Google Play Store		 b. iOS 
	 c. Hybrid App		  d. Gaming Apps

Test Sheet 1
(Based on chapters 1 to 6)

1.	 a. (iv)	 b. (iii)	 c. (iii)	 d. (ii) 
	 e. (ii)	 f. (ii)	 g. (iii)
2.	 a.	8	 b. Filter 	 c. Layer 	 d. terms 
	 e.	inline 	 f. Ctrl + R
3.	 a.	(T)	 b. (F)	 c. (T)	 d. (T)	 e. (F)
	 f.	 (T)
4.	 a.	Decimal is a base-10 number system, using digits from 0 to 9.
		  Hexadecimal is a base-16 number system, using digits 0-9 and letters A-F to represent values 

from 0 to 15.
		  In decimal, the value of each digit is a power of 10 (e.g., 10^0, 10^1, etc.), while in hexadecimal, 

the value of each digit is a power of 16 (e.g., 16^0, 16^1, etc.).
	 b.	 1  Select the data to be filtered and click on the Sort & Filter command. 
		  2  Select the Filter option. 
		  The list appears with the drop-down controls or the Filter switches on the right side of the 

column headings. 
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		  3  Click on Filter Switch. 
		  4  Tick the desired checkbox. 
		  5  Click OK button. 
	 c.	 1  Select the Gradient Tool from the toolbox (or press G).
		  2  Choose a gradient style from the Tool Options docker.
		  3  Click and drag on the canvas where you want the gradient to appear.
		  4  Release the mouse to apply the gradient between the start and end points.
	 d.	An iframe (inline frame) is used to embed another HTML document within the current page. 

It allows you to display content from other web pages in a small frame.
		  Example:
		  <iframe src="https://www.example.com" width="500" height="300"></

iframe>

		  This embeds the content of "example.com" within the page.
	 e.	Frames allow us to divide the web page into several independent parts or panes. The frames 

work as an independent window allowing multiple views at one time. 
	 f.	 A number system is a writing system for expressing numbers. It is based on a set of digits 

and a base value. The commonly used number systems are decimal (base 10), binary  
(base 2), octal (base 8), and hexadecimal (base 16).

5.	 a.	To convert a binary number to decimal, follow these steps:
		  1  Write down the binary number. 
		  2  Assign powers of 2 to each digit from right to left (starting with 2^0).
		  3  Multiply each binary digit (0 or 1) by the corresponding power of 2. 
		  4  Add the results together to get the decimal value. 
		  Example: Convert 1011 (binary) to decimal:
		  1 * 2^3 = 8
		  0 * 2^2 = 0
		  1 * 2^1 = 2
		  1 * 2^0 = 1
		  Sum: 8 + 0 + 2 + 1 = 11 (decimal)
	 b.	Conditional formatting is a feature in Excel that allows you to apply different formatting (e.g., 

color, font style) to cells based on specific conditions or criteria. It helps visually highlight 
important data or trends.

		  Example: You can use conditional formatting to highlight cells that are greater than a certain 
value, or cells that contain duplicate values.

	 c.	Following are the steps:
		  1  Open Krita and create or open a document.
	 	 2  Go to the "Layer" menu and select "New Layer" > "Import Layer".
		  3  Browse your computer to find the image you want to add.
		  4  Select the image and click "Open".
		  5  �The image will be added as a new layer in your document, and you can move or adjust it 

as needed.
	 d.	Lists and tables help organize content and present information clearly. Lists are useful 

for displaying ordered or unordered data (e.g., steps, items), while tables are essential for 
displaying structured data, like financial figures or schedules. They improve readability, 
accessibility, and navigation on web pages.

	 e.	ACTION: This attribute specifies what action should be taken once the SUBMIT button is 
clicked by the user. The Script URL specifies the location where the data collected by the 
form is submitted. It also produces a response in return. 

		  METHOD: This attribute specifies what will happen when the form is submitted. Two values 
can be assigned to the METHOD attribute, Get and Post. 

	 f.	 The octal number system is a base-8 number system that uses digits from 0 to 7. Each digit 
represents a power of 8, and it is often used in computing as a shorthand for binary data.

		  Example: The octal number 15 is equal to 13 in decimal (1 * 8^1 + 5 * 8^0).

 Google Apps 
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•  Gmail			  •  Google Drive

 

1.	 a. (iii)	 b. (i)	 c. (ii)	 d. (iii)
2.	 a. (T)	 b. (F)	 c. (T)	 d. (F)	 e. (F)
3.	 a.	Youtube 	 b. Google Docs	 c. Google Drive	 d. Google Slides 
	 e. Street View

7.
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4.	 a. Google Workspace is a collection of cloud-based productivity and collaboration tools 
developed by Google, including Gmail, Drive, Docs, Sheets, Calendar, and more.

	 b. Google Apps help users work collaboratively online, store and share data securely, 
communicate efficiently, and access files from any device.

	 c. Google Earth allows users to view detailed maps, satellite imagery, 3D buildings, and terrain. 
It helps users explore different parts of the world virtually.

	 d. Cloud computing is a technology that allows users to store and access data and applications 
over the internet instead of using local storage or hardware.

	 e. Google Slides is an online presentation tool by Google used to create, edit, and share slideshow 
presentations, similar to Microsoft PowerPoint.

	 f. Following are the steps:
		  1  Open your web browser and go to docs.google.com.
		  2  Sign in using your Google account.
		  3  Click on the + Blank template to create a new document.
		  4  Start typing or uploading your file.
	 g. Google Sheets is an online spreadsheet tool for creating, editing, and sharing data in rows 

and columns.
		  To share: Click Share, enter the email addresses, and choose permission (view, comment, 

edit).
		  To protect: Use Data > Protected sheets and ranges to restrict editing access to specific cells 

or ranges.
5.	 a. He should use Google Photos.
	 b. She should use Google Classroom.
	 c. She can use Google Forms.

COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

1.	 a. Hello (French)
	 b. Thank you (Spanish)
	 c. What is your name? (Italian)
	 d. I love the sunset(German)
2.	 French: Je m’appelle

 Cyber Security

uiz Bee
Page-126

1.	 Digital Footprints
2.	 Phishing

 

1.	 a. (iii)	 b. (ii)	 c. (i)	 d. (iii)
2.	 a. Cyber Security	 b. Hacker	 c. Phishing	 d. Computer Ethics
3.	 a. Computer ethics are rules that govern our actions when we use computers and the Internet.
	 b.	Hacking is the act of intruding into a computer system for harmful purposes by identifying 

the technical weak points of the security system using smart programming solutions.
	 c.	•  Avoid sharing your e-mail id with everyone. 
		  •  �Install a firewall on your computer as it does not allow hackers and viruses to get attached 

to your computer. 
		  •  �Do not share your personal information via e-mails. It must be shared only via smartphone 

or a secure website. 
		  •  Do not submit someone’s work without the permission of the contributors involved. 
		  •  Do not download any software without license. 
	 d.	Digital footprints or digital shadow are the traceable activities that we leave behind after 

surfing the Internet. All the activities performed by us on the Internet are recorded. 
		  ●	 All social media activities on Facebook, Twitter, Instagram, blogs, etc. 
		  ●	 Uploaded photos and videos 
		  ●	 Browsing history 
		  ●	 E-subscription 
		  ●	 Personal information 
		  ●	 Played online games 
		  Digital footprints are permanent and can be used by law enforcement agencies to find out 

the details about the offenders.

8.
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	 e.	This law aims to protect data privacy and information security. It validates digital signatures 
and contracts. According to this act, the owner of a given IP address will be held responsible 
for the content accessed or distributed through it.

	 f.	 Software piracy is the unauthorized copying or stealing of software, movies, music and making 
these copies available on the Internet. Every software has license. When we buy a software, 
we become an authorised user of that software.

4.	 a.	(i)
	 b.	Siddhartha should not provide his information because these types of mails are cyber attacks.

COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

1.	 333D	 2.  13%
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1.	 b. 		  2.  a. 		  3.  b.

 

1.	 a. (iii) 	 b. (i) 	 c. (ii) 
2. 	 a. F	 b. F	 c. T	 d. F	 e. T
3.	 a. 	Information processing involves acquiring, storing, analyzing, retrieving, and displaying data. 

Just like a computer, our brain acquires, processes, and stores information.
	 b.	An algorithm is a set of step-by-step instructions in a sequential manner to solve a problem.
	 c.	A computer stores and processes information using binary code. Information is first collected, 

filtered, sorted, processed, and stored in a readable format.
	 d.	An IF-THEN-ELSE condition in programming allows the program to make a decision: if the 

condition is true, one set of instructions is executed; otherwise, another set is executed.
	 e.	if day == "Sunday":
		      print("picnic")
		  else:
		      print("School")

9.
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Just like a computer, our brain acquires, processes, and stores information.
	 b.	An algorithm is a set of step-by-step instructions in a sequential manner to solve a problem.
	 c.	A computer stores and processes information using binary code. Information is first collected, 

filtered, sorted, processed, and stored in a readable format.
	 d.	An IF-THEN-ELSE condition in programming allows the program to make a decision: if the 

condition is true, one set of instructions is executed; otherwise, another set is executed.
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9.

4.	 Do it Yourself.

COding Zone
COding Zone
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1.	 Do it yourself.
2.	 if number % 3 == 0:

	     print("Divisible by 3")

	 else:

	     print("Not divisible by 3")

Periodic Assessment 3
(Based on chapters 7 to 9)

1.

Components 
Blocks

Built-in Blocks

Blocks Button

Backpack

Trash

Workspace

2.	 a.	Hacking is an illegal activity where someone gains unauthorized access to data or a computer 
system.

		  The traceable activity left behind after surfing the Internet is called a digital footprint.
	 b.	Phishing is an illegal practice of obtaining sensitive information such as usernames, passwords, 

or credit card details through fake e-mails.
	 c.	Cybercrime is a criminal activity carried out using computers or the Internet.The set of rules 

that governs our actions online is called cyber ethics or netiquette. 
	 d.	Spamming refers to the act of sending unwanted or junk e-mails to a large number of 

recipients, usually for advertising or malicious purposes.
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    Tokens and Data Types in Python
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AND operator are used to make decision on two conditions in Python.

 

1.	 a. (i)	 b. (i)	 c. (ii)	 d. (ii)	 e. (iii)

2.	 a. constant	 b. identifier	 c. Tuple	 d. semantic	 e. Data type

3.	 a.	Boolean data type represents truth values: True or False.

	 b.	‘1015’

	 c.	16

	 d.	Assignment Operators

	 e.	Errors are issues that prevent the program from running correctly.Syntax Error: print("Hello 
→ missing closing quote or bracket.Runtime Error: division by zero like a = 5/0.Logical Error: 
incorrect logic, no syntax mistake but wrong output.

	 f.	 Following is an example of assignment operator:

Addition 
assignment

+=
It adds the right operand to the left operand 
and assigns the result to left operand. x+=3 is 
equivalent to x=x+3.

x += 3

Operator Name Description
Example  

(x=2)

4.	 a. 7	 b. 2.0
	 c. False	 d. True
5.	 a. Relational operators 
	 b. Syntax error

10. COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

a.	 2.0
b.	 12
c.	 10 20 30
d.	 4 
	 True
e.	 True
f.	 4

    Future of Artificial Intelligence

uiz Bee
Page-156

Automated transportation will ensure that there are fewer accidents.

 

1.	 a. (i)	 b. (iv)	 c. (iii)	 d. (ii)
2.	 a. (T)	 b. (T)	 c. (T)	 d. (T)
3.	 a.	Traffic Management
	 b.	No red lights, no parking troubles, sound and air pollution free environments are some of 

the other important features.
	 c.	●  Automated Transportation
		  ●  Traffic Management
	 d.	AI enabled homes will let us turn on our lights, play favourite music or change our room 

temperature, by tapping the app on our smartphones. We can have our coffee ready when 
we wake up, automatically turn on and off ACs, lights, fans, etc.

4. 	 a. Smart Home
	 b. Smart Highway

11.
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COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

	 a.	2	 b. 1

Periodic Assessment 4
(Based on chapters 10 & 11)

1.	 a. True	 b. 100020	 c. 10  5  20	 d. True	 e. 20

2.	 a. Automated Transportation	 b. Traffic Management

	 c. Smart highway		  d. Safety and Security

3.	 a. Syntax error is a mistake in the program’s code structure, like missing a bracket.

		  Logical error occurs when the program runs but gives incorrect output due to wrong logic.

	 b.	Intelligent security uses AI-enabled systems, when someone tries to break into your home 
through the door or window, the motion sensor will send notifications to you.

Test Sheet 2
(Based on chapters 7 to 11)

1.	 a. (ii)	 b. (ii)	 c. (iii)	 d. (iii)	 e. (iii)

	 f. (i)	 g. (ii)

2.	 a. Google Drive	 b. Google Docs	 c. Digital Footprints

	 d. National Cyber Security policy, 2013

	 e. Constant	 f. Identifiers

3.	 a. (F)	 b. (T)	 c. (T)	 d. (F)	 e. (T)

	 f. (T)

4.	 a.	Components pane: This pane shows a list of all the components added to the screen in a 
hierarchical view. (Any one)

	 b.	●  No extra cost for hardware and software 

		  ●  No need to upgrade hardware and software 

		  ●  Secure and private Users’ collaboration

	 c.	Hacking is the act of intruding into a computer system for harmful purposes by identifying 
the technical weak points of the security system using smart programming solutions.

	 d.	Computer ethics are rules that govern our actions when we use computers and the Internet. 
Unacceptable actions in the cyber space are punishable by law.

	 e.	Operand.
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5.	 a.	if day == "Sunday":
		      print("picnic")

		  else:

		      print("School")

	 b.	When working with Google Sheets, you do not need to worry about saving a spreadsheet. It 
is saved automatically. You can decide who you want to share your file with and give them 
edit, comment, or view permissions. You can also protect specific data within your sheet so 
that those who have access to the sheet can only edit certain cells.

	 Sharing a File
	 Perform the following steps to share a spreadsheet:
		  1 	 Click on the Share button from the top-right corner of the spreadsheet.
		  2 	� Enter the email address(es) of the people with whom you want to share the spreadsheet 

in the box.
		  3 	 Click on Editor down-arrow.
		  4 	 Click on Editor option
		  5 	 Type a message for the receiver in the Message box.
		  6 	 Click on the Send button to share the file.
	 Protecting Data
	 Perform the following steps to protect a spreadsheet:
		  1 	 Select the Data option.
		  2 	 Select the protected sheets and range option.
		  3 	 Click on Set permissions button.	
	 c.	This law aims to protect data privacy and information security. It validates digital signatures 

and contracts. According to this act, the owner of a given IP address will be held responsible 
for the content accessed or distributed through it.

	 d.	These operators are used to assign value to a variable.

Assignment

Addition 
assignment

Subtraction 
assignment

=

+=

–=

It assigns the value of the operand on the right 
side to the left side operand. 

x = 5

It adds the right operand to the left operand 
and assigns the result to left operand. x+=3 is 
equivalent to x=x+3.

x += 3

It subtracts the right operand from the left operand 
and assigns the result to left operand. x–=3 is 
equivalent to x=x–3.

x –= 3

Operator Name Description
Example  

(x=2)
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Operator Name Description
Example  

(x=2)

Multiplication 
assignment

*=
It multiplies the right operand with the left operand 
and assigns the result to left operand. x*=3 is 
equivalent to x=x*3.

x *= 3

Division 
assignment

Floor division 
assignment

Remainder 
assignment

Exponentiation 
assignment

/=

//=

%=

**=

It divides the left operand with the right operand 
and assigns the result to left operand. x/=3 is 
equivalent to x=x/3.

It performs floor division on operators and assigns 
the value to the left operand. x//=3 is equivalent 
to x=x//3.

x /= 3

x //= 3

It takes the modulus of two operands and assigns the 
result to left operand. x%=3 is equivalent to x=x%3.

It performs exponential (power) calculation on 
operators and assigns the value to the left operand. 
x**=3 is equivalent to x=x**3.

x %= 3

x **= 3

	 e.	Errors are faults in a program. Errors prevent a program from executing accurately.
SYNTAX ERRORS 
A syntax error will occur when these rules and regulations are violated. For Example:
	� Python 3.9.5 (tags/v3.9.5:0a7dcbd, May 3 2021, 17:27:52) [MSC v. 1928 

64 bit (AMD64)] on win32

	 Type "help", "copyright", "credits" or "license()" for more information.

	 >>> Print("Hello")

	 Error: Invalid Syntax Type P in lowercase for the correct result.
	 NameError: name ‘Print’ is not defined

	 >>>print "Hello"

	 Error: Invalid Syntax Parentheses missing
	� SyntaxError: Missing parentheses in call to ‘print’. Did you mean 

print("Hello")?

	 >>> print("Hello")

	 Error: Invalid Syntax
	 Hello

	 >>>|
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LOGICAL ERRORS 
As the name suggests, these errors are related to the logic of the program. These errors are also 
known as semantic errors. They cause the program to behave incorrectly. They are the most difficult 
errors to fix but they do not usually crash the program. For example:
	� Python 3.9.5 (tags/v3.9.5:0a7dcbd, May 3 2021, 17:27:52) [MSC v. 1928 

64 bit (AMD64)] on win32

	 Type "help", "copyright", "credits" or "license()" for more information.

	 >>> # Example of Logical Errors in a program

	 >>> num1=float(input('Enter a number'))

	 Enter a number?

	 >>> num2=float(input('Enter another number'))

	 Enter another number 8

	 >>>average=num1+num2/2

	 >>> print(average)

	 11.0

	� Error: Invalid Logic: The average of 8 and 7 should be 7.5 Put num1 + num2 in braces as 
(num1+num2) for correct result.

	 >>>|


